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Using the TCP/IP Applications
This chapter is an introduction to the most commonly used Cisco TCP/IP Suite applications
and brief descriptions of the others. For detailed information about other features of these
applications and information about setting application options, see the online help for the
application.

The examples in this chapter use a workstation running Windows 95 or Windows NT. On
workstations running Windows 3.x, Cisco TCP/IP Suite programs look similar.

Topics covered in this chapter are:

• Starting Cisco TCP/IP Suite Applications

• Reading and Sending Email Using Netscape Mail

• Browsing the World Wide Web Using Netscape Navigator

• Reading Newsgroups Using Netscape News

• Logging into Hosts Using Telnet

• Retrieving Files from an FTP Server Using the FTP Client

• Connecting to NFS Network Drives and Printers

• Connecting to Networks Over a Modem Using Dialer

• Other Cisco TCP/IP Suite Components
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Starting Cisco TCP/IP Suite Applications
In Windows 95 and Windows NT, start Cisco TCP/IP Suite applications by selecting them
from the Cisco Suite 100 program group on the Start menu.

In Windows 3.x, start Cisco TCP/IP Suite applications by double-clicking their icons in the
Cisco Suite 100 program group in the Program Manager.

In several applications, you can also start the Net Tools application by clicking the Net
Tools button on the tool bar. The Net Tools application includes several utilities, such as
Ping, Finger, Host Lookup, and TraceRoute, that you might find useful while using those
applications.

Reading and Sending Email Using Netscape Mail
The Netscape Navigator includes an email program called Netscape Mail. You can use
Netscape Mail for all of your email requirements. However, if you already have email
software that uses WinSock, you should be able to continue using that software with Cisco
TCP/IP Suite.

Configuring Netscape Mail
Before you can use Netscape Mail to send and receive mail, you must configure Netscape
Mail so that it knows where to get your mail and where to send it.

To configure Netscape Mail:

Step 1 Start Netscape Navigator.

Step 2 ChooseOptions>Mail and News Preferences, and click the Servers tab.

Step 3 Enter the fully-qualified names of your outgoing (SMTP) mail server and your
incoming (POP) mail server. These servers are often the same machine. Contact
your network administrator if you are not sure of the names of your mail servers.

Step 4 Enter your account name in the POP User Name field.

Step 5 Determine whether you want copies of your mail left on the server when
Netscape Mail retrieves the mail, or whether you want the mail deleted from the
server. If you are configuring your primary system, you might want to delete the
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mail from the server. If you are configuring a secondary system (for example, a
laptop computer or home office machine), you might want to leave mail on the
server. That way, you can still access the mail from your primary system.

Step 6 If you want Netscape Mail to check your mail automatically, click Every beside
Check for Mail, and enter the number of minutes you want Netscape Mail to
wait between automatic checks. Netscape Mail must be running in order to
retrieve your mail automatically. If you have new mail, an exclamation point
appears in the lower right-hand corner of the mail window.

Step 7 Click the Identity tab and fill in the information about yourself. You can also add
a personalized signature file to the end of your messages by entering the name
of your signature file in the Signature File field. You must create the file using a
text editor, such as NotePad.

There are other mail options you can set, but these are the ones required to effectively use
Mail. See the Netscape online help for more information about configuring Navigator and
Mail.

Starting Netscape Mail
To start Netscape Mail, first start Netscape Navigator. You can then start Netscape Mail in
these ways:

• Click the envelope icon on the right side of Navigator’s status bar.

• ChooseWindow>Netscape Mail.

• ChooseFile>New Mail Message to create and send a new email message.

• ChooseFile>Mail Document to send a message attaching the file you are currently
viewing.

If you use Netscape Mail more often than Netscape Navigator, you can configure Navigator
so that Netscape Mail starts when you start Navigator:

Step 1 ChooseOptions>General Preferences and click the Appearance tab (if it is not
already in front).
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Step 2 Check Netscape Mail in the Startup group. If you also want Navigator to open,
leave Netscape Browser checked. Otherwise, uncheck Netscape Browser. (You
can open Navigator from the Netscape Mail window by choosingFile>New
Web Browser.)

Retrieving and Reading Email
To retrieve your mail, click theGet Mail button. New mail is added to the Inbox folder.

To read a piece of mail, select the Inbox (or other folder, if you have moved the mail to
another folder), and click on the mail in the list of mail. The contents of the mail appears in
the lower frame on the Netscape Mail window, which you can make larger by dragging the
top divider upward.

When you are finished reading a piece of mail, you can delete it by selecting the message
and clicking theDelete button. You can also move it to another folder, and out of your
Inbox, by dragging the message from the message list to the folder. This lets you save the
message without cluttering up your Inbox. You can create new folders by choosing
File>New Folder.

Sending Email
To create a new email message, click theTo:Mail  button. Enter the email address of the
person you are sending the message to in the To field, and those you are copying in the CC
field (if you enter more than one address in the To or CC fields, separate the addresses with
commas). Then, enter a subject for the message, and finally write your message. If you want
to attach a document to your message, click theAttachment button and choose the file or
Web location (URL) that you want to attach.

Once you are finished writing your message, click theSend button.

You can also create mail by:

• Clicking theRe:Mail  button when viewing a message to reply to the sender. Click the
Re:All  button to reply to the sender and copy everyone who was also sent the message.

• Clicking theForward  button when viewing a message to send the message to someone
else. You can also add your comments to the mail.
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Note If you are on a machine attached to the network over a modem, you might not
maintain a network connection at all times. If this is the case, you can have Netscape defer
sending your mail until you specifically tell Netscape to send it. When composing your
email, chooseOptions>Deferred Delivery. When you then click theSend button, the mail
is moved to the Outbox folder. When you do connect to the network, send the mail by
choosingFile>Send Mail in Outbox.

Creating and Using an Address Book
An address book is a list of people, their email addresses, and a nickname you can use in
the To field of an email message. If you create an address book entry for a person, you can
write to them without having to remember their email address. This is especially helpful if
the person has a difficult to remember or long address.

To add someone to the address book:

• If you are viewing a note from the person, chooseMessage>Add to Address Book.
Netscape Mail opens the Address Book dialog so that you can enter a nickname and a
description for the user.

• ChooseWindow>Address Book. You can add users by choosingItem>Add User. You
can also create a mailing list (a single nickname for a group of people) by choosing
Item>Add List .

To compose a message using your address book:

• When composing a message, click theMail To:  or CC: buttons. Netscape Mail opens
a dialog that lets you select users and add them to the To, CC, or BCC lists for the
message.

• ChooseWindow>Address Book, select the user or list, and chooseFile>Mail New
Message.

Browsing the World Wide Web Using Netscape Navigator
Use Netscape Navigator to browse HTML and other documents on the Internet’s World
Wide Web, or on your internal intranet. You can also use Navigator to view HTML
documents on your own system.
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Browsing Web Documents
To browse, or open, a document on the Web:

Step 1 Start Navigator.

Step 2 Click theOpen button, or chooseFile>Open Location.

Step 3 Enter the name of the location. This can include a file name, but it usually is just
the name of a site, which gives you the home page for that site. The name is
called a Universal Resource Locator (URL), because it does not depend on the
type of operating system you are using. For example, the name of the Cisco
Systems home page ishttp://www.cisco.com.

Once you are viewing a page on the Web, you can go from page to page using the
hyperlinks available on each page. Hyperlinks are usually underlined and in a different
color from the main text. Frequently, the graphics on a page are also hyperlinks. You can
tell whether a graphic or text is a hyperlink by moving your mouse cursor over the graphic
or text: if it is a link, your cursor changes shape. The name of the link is typically shown in
Navigator’s status bar.

Finding Information on the Web
There is a wealth of information available on the Web: the problem is finding the
information you are looking for. There are several search engines and directory services
offered on the Web. Click theNet Search or Net Directory buttons on the Navigator tool
bar to use Netscape’s facilities, which also include links to other search engines and
directory services.

Here are some other places for you to start your search, but this is not a complete list. As
you use the Web, you will find other resources.

• http://www.yahoo.com

• http://www.altavista.digital.com

• http://www.lycos.com

• http://www.excite.com
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Creating and Using Bookmarks
Navigator lets you create bookmarks for Web pages so that you can quickly return to pages
that you want to view again and again. You can create bookmarks to just about any Web
page, whether it is the home page for a site, or a specific page at a site. However, because
the content of the Web is ever-changing, you might find that a bookmark ends up pointing
to a page that no longer exists.

To create a bookmark, chooseBookmarks>Add Bookmark when viewing the page you
want to mark. The page is added to the list of bookmarks shown on the bottom part of the
Bookmarks menu.

To use a Bookmark, choose the bookmark from theBookmark menu. Navigator opens the
page named in the bookmark.

You can also delete bookmarks, edit the URL for a bookmark, import bookmark files for
Navigator or other web browsers, or even add a URL directly by choosingBookmark>Go
to Bookmarks. Navigator’s bookmark file is namedbookmark.htm; Enhanced Mosaic’s
bookmark file is namedhotlist.htm and is in the Windows installation directory (not the
Emosaic directory).

Configuring Navigator to Use Proxy Servers
Some networks require you to use proxy servers if you want to connect to systems outside
the network. This helps maintain the security of the network. If you have problems
connecting to sites on the Internet, contact your help desk or network administrator and ask
if you are required to use proxy servers. If you are, get a complete list of the servers you are
required to use, and any accounts on those servers that you need.

When you know the names of the proxy servers required for each type of Internet access,
enter the names of those servers on the Manual Proxy Servers configuration page (choose
Options>Network Preferences>Proxies tab and click theView button). If your site has an
automated proxy configuration, you can enter the URL for that location instead of manually
configuring the proxies.
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Reading Newsgroups Using Netscape News
You can read and create newsgroup postings using the Netscape News reader. Netscape
News is similar to Netscape Mail, and you must configure Netscape Mail if you want to
create news postings.

To start Netscape News, start Netscape Navigator and chooseWindow>Netscape News.

Configuring News Servers
To add a news server to the list of available news servers in Netscape News, choose
File>Open News Host, and enter the name of the news server you want to add to the list.

To set a news server as your default news server:

Step 1 ChooseOptions>Mail and News Preferences and click the Servers tab.

Step 2 Enter the name of the news server in the News Server field and clickOK .

Viewing Newsgroups and Reading News Postings
To view the postings available for a newsgroup, click on the newsgroup. The postings
appear in the window to the right of the list of news servers.

To read a posting, click on the posting. The contents appear in the bottom window.

Netscape News uses the settings on theOptions menu to determine which newsgroups to
show you. For example, if you selectOptions>Show Subscribed Newsgroups, only
newsgroups to which you are subscribed are shown. If you want to see all of the available
newsgroups, chooseOptions>Show All Newsgroups. However, make sure Netscape
News is not trying to contact a server when you change these settings: if Netscape News is
contacting a server, first click theStop button before changing your options.

Creating a News Posting
To add your own posting to a newsgroup, select the newsgroup and click theTo:News
button. When you are finished writing your message, click theSend button.

If you want to reply to someone else’s posting, select the posting and click theRe:News
button.
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Subscribing to a Newsgroup
To subscribe to a newsgroup, right-click on the newsgroup and chooseSubscribe.
Subscribing to the newsgroups you are interested in lets you quickly select these
newsgroups by choosingOptions>Show Subscribed Newsgroups to filter out all other
newsgroups.

To unsubscribe from a newsgroup, right-click the newsgroup and chooseUnsubscribe.

Logging into Hosts Using Telnet
Use Telnet to log into and use a remote host as if you were sitting at a real terminal
connected to the host. Telnet can emulate VT400, VT100, and VT52 terminals for
connecting to VMS and UNIX hosts; TN3270 terminals for connecting to VM and MVS
hosts; and TN5250 terminals for connecting to AS/400 hosts. There is also a selection of
international keyboards to suit your language requirements. You can also use Telnet to
connect to a host using Kerberos authentication, rlogin, and klogin (Kerberized rlogin).

Connecting to a Host Using Telnet
To connect to a host using Telnet:

Step 1 Start Telnet. Telnet opens the Connect dialog.

Step 2 Enter the name of the host.

Step 3 If you plan on using this host regularly, check Create Profile. Telnet creates a
profile for the host, which lets you connect to the host next time simply by
selecting the profile from the list of profiles.

Step 4 Click theConnect button. Telnet makes the connection and opens a terminal
window for the host.

Once the terminal window is open, you can log into the host.

Once the Telnet terminal emulation window is open, you can connect to other hosts by
clicking theConnect button on the tool bar.

When you are finished using the host, log off the host. Telnet automatically disconnects you
from the host.
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Creating and Using Telnet Profiles
Telnet can usually determine the type of terminal emulation required by the host, and
successfully negotiate the options required to make the connection you require, when you
initially connect to the host. Thus, it is easiest to create a Telnet profile by first connecting
to the host.

However, if Telnet cannot successfully negotiate the terminal emulation, you must first
create a profile for the host on the Connect dialog. Click theNew button, select the type of
emulation you require in the Force Emulation field on the Sign On tab, and select any other
options required to make the connection. Contact your network administrator, or the system
administrator for the host, for assistance.

You must also first create a profile if you want to use Kerberos authentication, rlogin, or
klogin. If you use Kerberos, Telnet prompts you to get a Kerberos ticket-getting ticket if
you do not already have one (use the Kerberos utility to identify your Kerberos server and
get Kerberos tickets).

When creating or modifying a profile, you can also create specialized keyboard maps. Click
theKeyboard button to open the Keyboard Remapper: consult the online help for detailed
information about using the utility. You can change the functions assigned to various keys,
and you can also assign a macro, or sequence of functions, to a single key.

If you already created a profile for a host, you can connect to the host by clicking theQuick
Connect button and choosing the profile from the list of existing profiles, if you already
have a terminal window open.

Changing Your Display and Other Current Settings
You can change your terminal display and other terminal settings for an active session by
clicking theSettings button. This opens the Settings dialog for the profile for the current
session. See the online help for detailed information for each setting.

Click the Display tab to change the display settings. You can select different fonts, colors,
and keyboard maps. If you want to change the number of rows and columns for the
terminal, click the tab for the current terminal emulation (VT, TN3270, TN5250) and select
the desired size.

To permanently change your settings, click theSave button in the Settings dialog. If you
only want to change your settings for the current session, click theApply  button.
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Retrieving Files from an FTP Server Using the FTP Client
Use the FTP Client to connect to an FTP server and copy files between your workstation
and the server. You can also create and delete files and directories on both the local and
remote hosts. You can connect to anonymous FTP servers as well as private servers on
which you have an account. FTP Client also supports:

• Passive connection mode, used with IP packet filtering firewalls

• Application firewalls

• SOCKS server firewalls

• Connections to OpenVMS hosts that use Secure/IP security

When you log into the remote host, the FTP Client automatically detects the type of host
and presents the host’s files and directory structure accordingly.

Connecting to an FTP Server Using FTP Client
To connect to an FTP Server using FTP Client:

Step 1 Start FTP Client. FTP Client opens the Connect dialog.

Step 2 Enter the name of the FTP server in the Host field.

Step 3 If you are making an anonymous login, check Anonymous Login. FTP Client
fills the user name and uses your email address for the password (the first time
you use anonymous login, FTP Client asks for your email address).

Otherwise, fill in the user name and password for your account on the FTP
server.

Step 4 Click theAdvanced button and fill in the appropriate options if you have any of
these requirements:

• You must connect through an IP packet filtering firewall (check Passive
Mode).

• You must connect through an FTP proxy server (fill in the information in the
Proxy Support group: see the online help for more information).

• You must enter an account code for the FTP server. Account codes are
sometimes required for IBM hosts.
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Step 5 If you plan on using this host regularly, enter a profile name and click theSave
button. FTP Client creates a profile for the host, which lets you connect to the
host next time simply by selecting the profile from the list of profiles, or from
the Quick Connect list.

Step 6 Click theConnectbutton to connect to the FTP server. FTP Client creates a
connection to the server and lists the server’s files in the Remote Host window
on the right side of the application’s window.

Step 7 When you are finished with the remote host, click theDisconnect button to
disconnect from the host.

Copying Files Using the FTP Client
You can navigate your workstation’s file system in the FTP Client’s Local window by
changing the drive and directories. Change the drive by choosing a new drive from the
drop-down list at the top of the Local window. Open and close directories by
double-clicking them.

You can navigate the FTP server’s file system in the FTP Client’s Remote window by
double-clicking the directories to open and close them. If the FTP Server is another
Windows machine, you can change drives by clicking theChange Dir button and entering
the drive letter, for example,D:\ . However, you can only enter drives and directories to
which you have been authorized.

Once you find the file you want to copy, and have the Local window opened to the directory
to which you want to copy the file, simply drag the file from the Remote window’s file list
to the Local window’s file list. If you are copying a file to the FTP server, drag the file from
the Local window to the Remote window.

You can copy more than one file at a time: select a range of files by selecting the first file
and shift-clicking the last file; select multiple individual files by Ctrl-clicking each file.
Once all files are selected, drag them to the other system.

You can also copy entire directories at once, by dragging the directory to the target directory
on the other system. FTP Client creates a subdirectory in the target directory for the copied
directory, and also copies any subdirectories and files for the copied directory.
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You can scale the directory and files windows with the horizontal and vertical window
resizing controls. You can slide the Control Bar to reveal full file details on the local side,
or you can remove it by uncheckingOptions>Control Bar.

Connecting to NFS Network Drives and Printers
The NFS utilities let you use network drives and printers, and printers connected to other
computers on the network, as if they were directly connected to your workstation.

On Windows 95, use NFS and Print Assistant to identify your NFS and print servers to
Windows; use Network Neighborhood or Windows Explorer to connect to NFS drives and
printers.

On Windows 3.x, use NFS Assistant to identify and connect to NFS drives, and Print
Assistant to connect to NFS printers; use Windows File Manager to look at files on the NFS
drives.

NFS and Print Assistant lets you map up to 24 drives concurrently, converts text and long
file names on the fly, provides full DOS window support, and supports PC-NFSD V2.0
authentication. You can use printers that use LPR, stream, or the PC-NFSD print protocol.
The NFS server can be a system running any type of operating system that supports NFS
and PC-NFS.

Adding NFS Servers to Your NFS Configuration
Use the NFS utilities to identify the NFS servers that have the drives and directories you
want to use.

Adding NFS Servers Under Windows 95
To add an NFS server to your NFS configuration on Windows 95 workstations:

Step 1 Start NFS and Print Assistant.

Step 2 Click theAdd button.
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Step 3 Enter the name of the NFS server in the Add Server dialog; for example,
nfs01.yoyodyne.com. Check all types of connections you want to make to this
server (ask your network administrator for the types of printer connections you
need):

• NFS Drive Mount Points if you want to connect to drives on the server.

• NFS Printer Mount Points if you want to connect to NFS print queues on
the server. The server shows you the print queues available in the Network
Neighborhood entry for the server.

• Stream Printing if you want to make a stream connection to a network
printer. Click theAdd button in the Stream Queues group to add a port for
the stream. The port number you need to use depends on the type of printer:
for example, 9100 is for Hewlett-Packard printers. Ask your network
administrator for the port number required for the network printer, or consult
the printer’s documentation.

• LPR Printing  if you want to make a connection to an LPR/LPD print server.
Click theAdd button in the LPR Queues group and add the names of the
printer queues you want to use. Ask your network administrator for the
names of these queues.

Once you have added the NFS servers to the configuration, you can access the server’s
drives and printers through the NFS Servers and Printers entry in the Windows 95 Network
Neighborhood.

Adding NFS Servers Under Windows 3.x
To add an NFS server to your NFS configuration for making network drive connections on
Windows 3.x workstations:

Step 1 Start the NFS Assistant and click the Servers tab.

Step 2 Enter the name of the NFS server in the New Server Name field; for example,
nfs01.yoyodyne.com.

Step 3 Click theAdd button to add it to the list of available servers.
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To add NFS servers and printers for making print connections on Windows 3.x
workstations:

Step 1 Start Print Assistant and click the Servers tab.

Step 2 Enter the name of the NFS server or printer in the New Server Name field; for
example, nfs01.yoyodyne.com.

Step 3 Click theAdd Server button to add the server.

Step 4 When you add the server, the Queues dialog appears so that you can add the
printer queues. Check all connection types that you want to enable:

• Enable NFS if you want to connect to NFS print queues on the server. The
server shows you the print queues available on the Print Assistant’s
Connection tab.

• Enable Stream if you want to make a stream connection to a network
printer.

• Enable LPR/LPD if you want to make a connection to an LPR/LPD print
server. Enter the names of the print queues and click theAdd button. Ask
your network administrator for the names of these queues.

Connecting to NFS Drives
Once you have added the NFS servers to your NFS configuration, you can connect to mount
points (drives or directories) on the NFS server.

Although the NFS client is not case-sensitive, it preserves the case of file names on the NFS
drives.

Also, when you browse a server’s mount points, embedded or trailing slashes appear as %
signs. However, if you enter the name of a mount point directly, use slashes, not the % sign.

Connecting to an NFS Drive Under Windows 95
To connect to an NFS drive on a Windows 95 workstation:

Step 1 Open Network Neighborhood and find the NFS Servers and Printers workgroup
entry in the Entire Network entry. This list shows all NFS servers you have
added to your NFS configuration.
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Step 2 Double-click the name of the server to which you want to connect. The available
directories (mount points) appear as folders. You can view the contents of the
folders by double-clicking and browsing them just as you would if you were
looking at your own drive in My Computer. (You must log into the NFS server
before you can see the files: see the next step.)

Step 3 If you want to connect the network drive to a drive letter on your workstation
(for example, if you always want Windows to connect to the drive when you boot
your workstation), right-click the directory name (mount point) and chooseMap
Network Drive.

Once you choose a drive letter for the connection, you must log into the NFS
server. Enter your user name and password. If you have trouble logging into the
server, ask your network administrator if you have a proper account, or if you
need to use a different server to authenticate your connection. If you need to use
an authentication server, enter the name of the server in the Authentication
Server field on the NFS login dialog.

Once connected to an NFS drive, you can use it like any other drive on your workstation.
You can drag and drop files between the drive and other drives using My Computer or
Windows Explorer.

You can also connect to a drive by choosingTools>Map Network Drive in Windows
Explorer, and entering the UNC for the mount point; for example,
\\server.yoyodyne.com\nfsmount.

To disconnect from a drive, right-click it in My Computer or Windows Explorer and choose
Disconnect.

Connecting to an NFS Drive Under Windows 3.x
To connect to an NFS drive on a Windows 3.x workstation:

Step 1 Start the NFS Assistant and click the Connections tab. The NFS servers list
shows the servers you have already added to your NFS configuration.

Step 2 Double-click the name of the server to which you want to connect. The available
directories (mount points) appear as folders.

Step 3 Select the desired mount point.
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Step 4 Choose an available drive for this connection from the Available Drives
drop-down list and click theConnect button.

Step 5 Log into the NFS server. Enter your user name and password. If you have trouble
logging into the server, ask your network administrator if you have a proper
account, or if you need to use a different server to authenticate your connection.
If you need to use an authentication server, enter the name of the server in the
Authentication Server field on the NFS Connect dialog.

If you want Windows to reconnect this drive every time you boot the
workstation, check Reconnect at Startup on the login dialog.

Once connected to an NFS drive, you can use it like any other drive on your workstation.
You can drag and drop files between the drive and other drives using File Manager.

To disconnect from a drive, choose it in the NFS Assistant Current Connection list and click
theDisconnect button.

Connecting to Network Printers
Once you have added the NFS servers to your NFS configuration, you can connect to
printers connected to the NFS server, or to stream or LPR print queues. Before connecting
to a printer, ensure you have the print drivers required for the printer: have the Windows
installation media ready if you need to install the drivers.

Connecting to a Network Printer Under Windows 95
To connect to a network printer on a Windows 95 workstation:

Step 1 Open Network Neighborhood and find the NFS Servers and Printers workgroup
entry in the Entire Network entry. This list shows all NFS servers and printers
you have added to your NFS configuration.

Step 2 Double-click the server to which the printer is connected. (For stream printers,
the name of the printer is the server.)
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Step 3 Double-click the desired printer. Windows 95 prompts you through the process
of installing the printer. You might need the Windows 95 installation media if
you do not already have the appropriate printer drivers installed. Once the printer
is installed, you can print to it as if it were directly connected to your
workstation.

Some applications require an LPT port number mapping to print. Right-click the printer
icon, chooseProperties, and click theCapture Printer Port  button on the Details tab.

Connecting to a Network Printer Under Windows 3.x
To connect to a network printer on a Windows 3.x workstation:

Step 1 Install the printer drivers required by the printer.

Step 2 Start the Print Assistant and click the Connections tab.

Step 3 Double-click the server name, and double-click the type of printer connection
you want to make. You get a list of possible printer connections.

Step 4 Click the desired printer, and choose an available printer port for the connection.

Step 5 Click Connect. If Print Assistant requires more information about the printer, it
asks you for it (ask your network administrator for help if you are not certain
about port numbers or queue names). Once the printer is installed, you can print
to it as if it were directly connected to your workstation.

Connecting to Networks Over a Modem Using Dialer
Use Dialer to connect to a remote network over a serial connection, which is typically a
modem and telephone line, but can also be a direct connection. This is a common way of
connecting to the Internet without having a direct Ethernet connection.

Dialer provides a complete scripting interface as well as a manual dialing mode, allowing
you to establish either PPP (Point-to-Point Protocol) or SLIP (Serial Line IP) connections.
You can connect to a host by using the manual mode, and then write a script to automate
the process for subsequent use.

Once you are connected to the remote network, you can use TCP/IP and
WinSock-compliant applications.
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Preparing to Make a Serial Connection
Before connecting to a remote host using the Dialer, you must complete these tasks:

• Get an account on the remote host. You need to know:

— Your user name, if any

— Your password, if any

— The telephone numbers of the host

— The type of connection the host supports (PPP or SLIP). If the host supports both
types, use PPP: it is more robust and reliable.

— Whether you will be dynamically assigned an IP address when you connect, or
whether you must use a specific IP address.

— The IP addresses of the DNS servers, if any.

— The IP addresses of any routes you must use, if there are any besides your own
workstation.

— Any other authorization requirements, such as a user name or password for PAP or
CHAP authorization.

• Configure your workstation for serial connections:

— Use the Configuration Utility to add a serial interface. See the Configuration
Utility’s online help for more information.

— If you are only using serial network connections on the machine (for example, you
do not have an Ethernet connection), you must install the Cisco Dial-Up Adapter.
Open the Windows Network Properties Control Panel; click theAdd button and
choose Adapter. Then choose Cisco as the Manufacturer and select the Cisco
Dial-Up Adapter. When you configure the software, bind it to this adapter.

— If you are going to initially make a manual connection to the host (which we
recommend, unless your network administrator can supply you with a tested Dialer
script for the host), chooseManual Connect>Configure in Dialer and configure
the manual interface. You need to know your modem speed and port, as well as the
other information previously mentioned.

See Dialer’s online help for more detailed information about the information needed for
configuring and completing serial connections.
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Making a Manual Serial Connection Using Dialer
To manually connect to a remote network over a serial line:

Step 1 Start Dialer.

Step 2 Click theManual Connect button on the tool bar.

The Manual Connect dialog appears. This window includes a complete VT-style
communications module that lets you interact with the modem directly. You
must be careful how you type in this window: you cannot erase a mistake by
backspacing over it. All typing is sent directly to the modem. If you paste text
into the window, that text must be a modem command. If you find that your
typing is not visible, reset the modem by typing ATZ or AT&F and pressing
Enter.

Step 3 In the Terminal View window, enter the command for dialing the remote host.
This is usuallyatdt followed by the telephone number. Include all numbers
required for dialing the host. For example, if you must dial 9 to get an outside
telephone line, you must include 9 in the telephone number. Use a comma to
indicate that Dialer should pause between numbers when dialing. For example,
to dial 555-1212 when you need to dial 9 first, enter:

atdt 9,555-1212

Step 4 If Dialer successfully connects to the remote host, you see text sent from the
remote host. Log into the host using the user name, password, and other
information required by the host. Ask your network administrator for this
information. (If you are using PAP or CHAP authorization, and immediately
begins sending PPP packets, click thePPP button immediately to complete the
connection.)

Step 5 Start PPP or SLIP on the remote host using the command supplied by the
network administrator. Then:

• For PPP, click thePPP button once the remote host starts sending binary data
(unreadable text).
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• For SLIP, if you are using dynamically-assigned IP addresses, enter the IP
address in the IP address field when the remote host sends you the IP address,
and click theSLIP button. If you are not using dynamically-assigned IP
addresses, the IP address should already be in the IP address field, so you
only have to click theSLIP button.

If you want to create a profile for the connection, click thePrint  button before
clicking thePPP or SLIP button.

Dialer attempts to complete the connection. Once the connection listed in Dialer’s main
window shows theActive status, you can start using network applications.

When you are finished using the remote network, click theDisconnect button.

Creating Profiles for Serial Network Connections
If you plan to use Dialer to connect to a network regularly, create a profile for the
connection to simplify the connection process. When you have a profile, you can quickly
connect to the remote network by choosing the profile from theQuick Connect list.

Before creating a profile for a remote network, make a manual connection to the host and
print the your interaction with the host. You will need this to create a script to automate the
logon procedure.

Once you have the printout, click theConnect button and then theNew button on the
Connect dialog. Enter a profile name and then, in the Settings dialog, configure the interface
as required. See the online help for detailed information about creating a Dialer script.

Other Cisco TCP/IP Suite Components
This section describes Cisco TCP/IP Suite applications and other features not described in
the previous sections. Use the online help for directions on using the applications.
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Cisco TCP/IP Stack and Configuration Utility
The TCP/IP stack is the underlying software that handles communications for Cisco
TCP/IP Suite applications. The stack’s unique, layered architecture includes a kernel API
(application program interface) and a DPC (Deferred Procedure Call) layer optimized for
Windows.

The kernel API is designed specifically for WinSock so that it minimizes communications
between WinSock and the kernel. Because the stack fully supports the WinSock V1.1 API,
you can run any WinSock-compliant application over the TCP/IP stack without any
changes.

The Cisco TCP/IP Suite kernel supports multiple raw sockets, MTU path discovery,
supernets and subnets, dynamic routing, and IP multicasting.

The Configuration Utility offers advanced options for configuring interfaces, routing, DNS,
host tables, ARP, host names, domain names, LM host tables, and NetBIOS over TCP/IP.

FTP Server
The FTP Server lets you set up your workstation so that users you authorize can access files
on your workstation. The FTP Server provides password authentication and directory-level
access control, and supports anonymous FTP and passive mode.

Monitor
The Monitor application provides detailed information about your workstation’s TCP/IP
communications. It lets you view your workstation’s current ARP cache, buffer statistics,
TCP/IP connections, configured interfaces, protocol statistics, and routing table.

Kerberos
The Kerberos application authenticates user access to a remote system without openly
sending passwords over the network. This type of authentication, which uses encrypted
keys called tickets, prevents intruders from breaking into systems by capturing passwords.

The Kerberos application lets you initialize Kerberos tickets, start Kerberized sessions, list
your current tickets, and delete tickets you no longer need.
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Net Tools
The Net Tools application is a set of TCP/IP utilities mainly used for looking up
information about users or machines, or on checking the condition of the network. Utilities
include Ping, Finger, TraceRoute, Whois, and Host Lookup.

Ping
The Ping utility lets you check on whether a machine on the network is active and
responding to network requests. If a machine responds to a Ping, you know that the machine
is on and its TCP/IP connection is active. However, the machine may not be able to respond
to other networking requests.

Version Information
Version Information displays Cisco TCP/IP Suite license keys currently installed on your
machine and provides complete version information for each installed component. This
information is useful when diagnosing potential sources of problems.

You can start Version Information from the Cisco Suite 100 program group or the system
menu in the Configuration Utility.

SNMP Agent
A workstation running the Cisco SNMP (Simple Network Management Protocol) agent can
be managed by a network administrator from a remote system configured as an SNMP
network manager. Because SNMP is an open standard, SNMP network management
software and SNMP agent software from different vendors can be mixed and matched.

You can configure the SNMP Agent to send all standard SNMP traps (notifications of errors
and other significant events on the agents). The SNMP Agent responds to all SNMP
network manager queries.

SNMP maintains information about your workstation in a MIB (management information
database). The Cisco TCP/IP Suite agent complies with the Internet-standard MIB II
definition and is based on the SNMPv1 definition.

The SNMP Agent must be running in order for an SNMP network manager to maintain
your workstation. See the online help for information on starting the agent automatically.
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Localization and Internationalization
Localized versions of the Cisco TCP/IP Suite applications are available for many
languages. Contact your Cisco sales representative to see if the applications are available
in a specific language.

Internationalization refers specifically to installation and terminal emulation. You can
install the US English version of the Cisco TCP/IP Suite in localized versions of Windows.
The Telnet application in this release of Cisco TCP/IP Suite emulates country-specific
terminal behavior for UK English, French, German, Swedish, Danish, Swiss German,
Swiss French, Norwegian, Finnish, and Belgian.


